Chapter 393

GEE Tests for the TAD of Multiple Groups in a Repeated Measures Design (Continuous Outcome)

Introduction

This module calculates the power for testing for differences among the time-averaged responses of two or more means from continuous, correlated data that are analyzed using the GEE method. Such data can occur in two design types: clustered and longitudinal. This procedure provides results for the longitudinal design.

GEE is different from mixed models in that it does not require the full specification of the joint distribution of the repeated measurements, as long as the marginal mean model is correctly specified. Estimation consistency is achieved even if the correlation matrix is incorrect. Also, the correlation matrix of the responses is specified directly, rather than using an intermediate, random effects model as is the case in MM. For clustered designs, GEE often uses a compound symmetric (CS) correlation structure. For longitudinal data, an autoregressive (AR(1)) correlation structure is often used.

Time-averaged response analysis is often used when the outcome to be measured varies with time. For example, suppose that you want to compare three treatment groups based on the means of a certain outcome such as blood pressure. It is known that a person's blood pressure depends on several instantaneous factors such as amount of sleep, excitement level, mood, exercise, etc. If only a single measurement is taken from each patient, then the comparison of mean values from the groups may be insensitive because of the large degree of variation in blood pressure levels within patients. The precision of the experiment is increased by taking multiple measurements from each individual and comparing the time-averaged response among the groups. Care must be taken in the analysis because of the correlation that is introduced when several measurements are taken from the same individual. The correlation structure may take on several forms depending on the nature of the experiment and the subjects involved.

Missing Values

This procedure allows you to specify various patterns of incomplete (or missing) data. Subjects may miss some appointments but attend others. This phenomenon of incomplete data can be accounted for in the sample size calculation which can greatly reduce the overall sample size from that calculated by just omitting subjects with incomplete observations.
Technological Details

Theory and Notation

Suppose we have $n_k$ ($k = 1, \ldots, G$) subjects in each of $G$ groups for a total of $N$ subjects, each measured on $m$ occasions at times $t_j$ ($j = 1, \ldots, M$). For convenience, we normalize these time points to the proportion of total time so that $t_1 = 0$ and $t_m = 1$.

The mean of $y_{kij}$ is modeled by

$$y_{kij} = \mu_k + \epsilon_{kij}$$

where

$y_{kij}$ is the $j^{th}$ response from subject $i$ in group $k$, with variance given by $\sigma^2$,

$r_k$ is the proportion of subjects in group $k$,

$\mu_k$ is group-specific treatment effect ($k = 1, \ldots, G$),

$\epsilon_{kij}$ is a zero-mean error term with variance $\sigma^2$.

In this procedure, the primary interest is to test $H_0: \mu_1 = \cdots = \mu_G$ against the alternative that at least one mean is different.

GEE is used to estimate and test hypotheses about these group means. $H_0$ is rejected with a type I error $\alpha$ if

$$B'W^{-1}B > \chi^2_{G-1,1-\alpha}$$

where $\chi^2_{G-1,1-\alpha}$ is the $100(1 - \alpha)$th percentile of a chi-square distribution with $G-1$ degrees of freedom. The mean deviation vector $B$ is given by

$$B = \sqrt{N}(\hat{\mu}_1 - \bar{\mu}, \ldots, \hat{\mu}_G - \bar{\mu})'$$

and $W$ is a consistent estimate of the variance matrix based on the residuals.

Correlation Patterns
In a longitudinal design with $N$ subjects, each measured $M$ times, observations from a single subject are correlated, and a pattern of those correlations through time needs to be specified. Several choices are available.

Compound Symmetry
A compound symmetry correlation model assumes that all correlations are equal. That is

$$[p_{jj'}] = \begin{bmatrix}
1 & \rho & \rho & \rho & \cdots & \rho \\
\rho & 1 & \rho & \rho & \cdots & \rho \\
\rho & \rho & 1 & \rho & \cdots & \rho \\
\rho & \rho & \rho & 1 & \cdots & \rho \\
\vdots & \vdots & \vdots & \vdots & \ddots & \vdots \\
\rho & \rho & \rho & \rho & \cdots & 1
\end{bmatrix}_{M \times M}$$

where $\rho$ is the baseline correlation.
Banded(1)
A Banded(1) (banded order 1) correlation model assumes that correlations for observations one time period apart are equal to $\rho$, and correlations for measurements greater than one time period apart are equal to zero. That is

$$
\begin{bmatrix}
1 & \rho & 0 & 0 & \cdots & 0 \\
\rho & 1 & \rho & 0 & \cdots & 0 \\
0 & \rho & 1 & \rho & \cdots & 0 \\
0 & 0 & \rho & 1 & \cdots & 0 \\
\vdots & \vdots & \vdots & \vdots & \ddots & \vdots \\
0 & 0 & 0 & 0 & \cdots & 1 \\
\end{bmatrix}_{M \times M}
$$

where $\rho$ is the baseline correlation.

Banded(2)
A Banded(2) (banded order 2) correlation model assumes that correlations for observations one time period or two periods apart are equal to $\rho$, and correlations for measurements greater than one time period apart are equal to zero. That is

$$
\begin{bmatrix}
1 & \rho & \rho & 0 & \cdots & 0 \\
\rho & 1 & \rho & \rho & \cdots & 0 \\
\rho & \rho & 1 & \rho & \cdots & 0 \\
0 & \rho & \rho & 1 & \cdots & 0 \\
\vdots & \vdots & \vdots & \vdots & \ddots & \vdots \\
0 & 0 & 0 & 0 & \cdots & 1 \\
\end{bmatrix}_{M \times M}
$$

where $\rho$ is the baseline correlation.

AR1 (Traditional)
This version of AR1 (autoregressive order 1) correlation model assumes that correlations $t$ time periods apart are equal to $\rho^t$. That is

$$
\begin{bmatrix}
1 & \rho & \rho^2 & \rho^3 & \cdots & \rho^{M-1} \\
\rho & 1 & \rho & \rho^2 & \cdots & \rho^{M-2} \\
\rho^2 & \rho & 1 & \rho & \cdots & \rho^{M-3} \\
\rho^3 & \rho^2 & \rho & 1 & \cdots & \rho^{M-4} \\
\vdots & \vdots & \vdots & \vdots & \ddots & \vdots \\
\rho^{M-1} & \rho^{M-2} & \rho^{M-3} & \rho^{M-4} & \cdots & 1 \\
\end{bmatrix}_{M \times M}
$$

where $\rho$ is the baseline correlation.

AR1 (Proportional)
This version of AR1 (autoregressive order 1) correlation model is described in the book by Ahn et al. (2015). It assumes that correlations $|t_j - t_k|$ time periods apart are equal to $\rho^{|t_j - t_k|}$. That is

$$
\begin{bmatrix}
1 & \rho & \rho^2 & \cdots & \rho^{M-1} \\
\rho & 1 & \rho & \cdots & \rho^{M-2} \\
\rho^2 & \rho & 1 & \cdots & \rho^{M-3} \\
\rho^3 & \rho^2 & \rho & \cdots & \rho^{M-4} \\
\vdots & \vdots & \vdots & \ddots & \vdots \\
\rho^{M-1} & \rho^{M-2} & \rho^{M-3} & \rho^{M-4} & \cdots & 1 \\
\end{bmatrix}_{M \times M}
$$

where $\rho$ is the baseline correlation. Note that in this pattern, the value of $\rho$ is shown in the final column since in this case $t_j = 0$ and $t_k = 1$, so $|t_j - t_k| = 1$.  

393-3
Dampened Exponential

A dampened exponential is an extension of the AR(1) correlation model in which the exponents are raised to the power $D_{\text{exp}}$ ($\theta = D_{\text{exp}}$ in the diagram below). This causes the resulting correlations to be reduced (dampened). Here is an example

$$
\begin{bmatrix}
1 & \rho & \rho^2 \theta & \rho^3 \theta & \ldots & \rho^{(M-1)} \theta \\
\rho & 1 & \rho & \rho^2 \theta & \ldots & \rho^{(M-2)} \theta \\
\rho^2 \theta & \rho & 1 & \rho & \ldots & \rho^{(M-3)} \theta \\
\rho^3 \theta & \rho^2 \theta & \rho & 1 & \ldots & \rho^{(M-4)} \theta \\
\vdots & \vdots & \vdots & \vdots & \ddots & \vdots \\
\rho^{(M-1)} \theta & \rho^{(M-2)} \theta & \rho^{(M-3)} \theta & \rho^{(M-4)} \theta & \ldots & 1
\end{bmatrix}_{M \times M}
$$

where $\rho$ is the baseline correlation.

Dampened Exponential (Proportional)

This version of the dampened exponential correlation model is described in the book by Ahn et al. (2015). It assumes that correlations $|t_j - t_k|$ time periods apart are equal to $\rho^{[t_j-t_k] \theta}$. That is

$$
\begin{bmatrix}
\rho_{jk}
\end{bmatrix} = \begin{bmatrix}
\rho^{[t_j-t_k] \theta}
\end{bmatrix}_{M \times M}
$$

where $\rho$ is the baseline correlation. Note that in this pattern, the value of $\rho^{[t_j-t_k] \theta}$ turns up in the final column since in this case $t_j = 0$ and $t_k = 1$, so $|t_j - t_k| = 1$.

Linear Exponential Decay

A linear exponential decay correlation model is one in which the exponent of the correlation decays according to a linear equation from 1 at the Base Time Proportion to a final value, $E_{\text{max}}$. The resulting pattern looks similar to the dampened exponential. Note that the exponents are applied to the absolute difference between the Measurement Time Proportions. This method allows you to easily construct comparable correlation matrices of different dimensions. Otherwise, differences in the resulting power would be more strongly due to differences in the correlation matrices.

Here is an example. Suppose $M$ is 6, $\rho = 0.5$, $E_{\text{max}} = 3$, the Base Time Proportion is 0.20, and the Measurement Time Proportions are (0, 0.2, 0.4, 0.6, 0.8, 1). The following correlation matrix would be obtained

$$
\begin{bmatrix}
1 & 0.5 & 0.3536 & 0.25 & 0.1768 & 0.125 \\
0.5 & 1 & 0.5 & 0.3536 & 0.25 & 0.1768 \\
0.3536 & 0.5 & 1 & 0.5 & 0.3536 & 0.25 \\
0.25 & 0.3536 & 0.5 & 1 & 0.5 & 0.3536 \\
0.1768 & 0.25 & 0.3536 & 0.5 & 1 & 0.5 \\
0.125 & 0.1768 & 0.25 & 0.3536 & 0.5 & 1
\end{bmatrix}_{M \times M}
$$

Note that in the top row, the correlation is 0.5 for the second (0.2 - 0) time point and 0.125 (0.5^3) at the last (1 - 0) time points. The correlations are obtained by raising 0.5 to the appropriate exponent. The linear equation from 1 to 3 results in the exponents 1, 1.5, 2, 2.5, 3 correspondent to the time proportions 0, 0.2, 0.4, 0.6, 0.8, and 1.

As a further example, note that the correlation for the 0.4 time point is, $0.5^{1.5} = 0.35355339 \approx 0.3536$. 

\[\text{393-4}\]
This method allows you to compare various values of $M$ while keeping the correlation matrix similar. To see what we mean, consider what the correlation matrix looks like when $M$ is reduced to 4 and the measurement time proportions are set to $(0, 0.2, 0.6, 1)$. It becomes

$$[ho_{jj'}] = \begin{bmatrix}
1 & 0.5 & 0.25 & 0.125 \\
0.5 & 1 & 0.5 & 0.25 \\
0.25 & 0.5 & 1 & 0.5 \\
0.125 & 0.25 & 0.5 & 1
\end{bmatrix}
_{M \times M}
$$

Note that the correlation at a measurement time difference of 0.6 is equal to 0.25 in both matrices.

### Missing Data Patterns

The problem of missing data occurs for several reasons. In longitudinal studies in which a subject is measured multiple times, missing data becomes more complicated to model because it is possible that a subject is measured only some of the time. In fact, it is probably more common for data to be incomplete than complete. The approach of omitting subjects with incomplete data during the planning phase is very inaccurate. Certainly, subjects with partial measurements are included in the analysis. This procedure provides several missing data patterns to choose from so that your sample size calculations are more realistic.

In the presentation to following, we denote the percent of subjects with a missing response at time point $t_j$ as $\kappa_j$. The proportion non-missing at a particular time point is $\phi_j = 1 - \kappa_j$. We will refer to $\phi_j$ as the marginal observant probability at time $t_j$ and $\phi_{jj'}$ as a joint observant probability at times $t_j$ and $t_{j'}$.

### Pairwise Missing Pattern

The program provides three options for how the pairwise (joint) observant probabilities $\phi_{jj'}$ are calculated. These are

- **Independent (Ind):** $\phi_{jj'} = \phi_j \phi_{j'}$, $\phi_{jj} = \phi_j$
- **Monotonic (Mon):** $\phi_{jj'} = \phi_k$ where $k = \max(j, j')$
- **Mixture:** $\phi_{jj'} = W(\text{Ind}) + (1 - W)(\text{Mon})$ for weighting factor $W$.

### Missing Input Type

There are several ways in which the missing value pattern can be specified. Each missing value pattern is a list of missing proportions at each of the $M$ time points. Each value in the list must be non-negative and less than 1. Possible input choices are

- **Constant = 0**
  All missing proportions are set to 0. That is, there are no missing values.

- **Constant**
  All missing proportions are set to constant value.

- **Piecewise Constant on Spreadsheet**
  A set of missing proportions are defined for several time intervals using the spreadsheet. One column contains the missing proportions for the interval, going down the rows. Another column defines the corresponding upper limit of time proportion of the interval. The lower limit is implied by the limit given immediately above. The program assumes that the first time interval starts at 0 percent.
• **Linear (Steady Change)**
The missing proportions fall along a straight-line between 0 and 1 elapsed time. Only the first and last proportions are entered.

• **Piecewise Linear on Spreadsheet**
The missing proportions fall along a set of connected straight-lines that are defined by two columns on the spreadsheet.

• **List**
Enter a list of M missing proportions, one for each time point.

• **Multiple Lists on Spreadsheet**
Select multiple columns containing vertical lists of missing proportions. Each column contains a set of missing proportions in rows, one for each time point.

• **Pairwise Observed Proportions on Spreadsheet**
Enter an $M \times M$ matrix of observant probabilities by selecting M columns. These observant probabilities are the proportion of the responses for both the row and column time points that are observed.

### Sample Size Calculations
The details of the calculation of sample size and power is given in Ahn, Heo, and Zhang (2015), Chapter 4. These are summarized here.

As explained above, GEE is used to estimate the regression coefficients. Under the alternative hypothesis, as $N$ approaches infinity, the test statistic $B'W^{-1}B$ is approximately distributed as a noncentral chi-square random variable with $G - 1$ degrees of freedom and noncentrality parameter $U = N\eta'W^{-1}\eta$

where

$$\eta' = (\mu_1 - \bar{\mu}, \ldots, \mu_{G-1} - \bar{\mu})$$

$$\bar{\mu} = \sum_{k=1}^{G} r_i \mu_i$$

$$\eta'W^{-1}\eta = \frac{\bar{m}^2}{s} \left[ \sum_{k=1}^{G-1} r_k \eta_k^2 + \frac{1}{r_G} \left( \sum_{k=1}^{G-1} r_k \eta_k \right)^2 \right]$$

$$\bar{m} = \sum_{k=1}^{G} \phi_k$$

$$s = \sigma^2 \sum_{j=1}^{m} \sum_{j'=1}^{m} \phi_{jj'} \rho_{jj'}$$

This noncentral distribution can be used to calculate the power using the following

$$Power = Pr(\chi^{2}_{G-1}(U) > \chi^2_{G-1,1-\alpha})$$

Using this power function, the sample size can be determined using a simple binary search.
Procedure Options

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab

The Design tab contains most of the parameters and options that you will be concerned with.

Solve For

Solve For

This option specifies the parameter to be solved for. When you choose to solve for Sample Size, the program searches for the lowest sample size that meets the alpha and power criterion you have specified. The Solve For parameter is displayed on the vertical axis of the plot.

Power and Alpha

Power

This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of equal slopes when in fact the slopes are different.

Values must be between zero and one. Historically, the value of 0.80 (beta = 0.20) was used for power. Now, 0.90 (beta = 0.10) is also commonly used.

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.

Alpha

This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true null hypothesis is rejected. In this procedure, a type-I error occurs when you reject the null hypothesis of equal slopes when in fact the slopes are equal.

Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents the risk of a type-I error you are willing to take in your experimental situation.

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size and Group Allocation

G (Number of Groups)

This is the number of groups (arms) whose means are being compared. The number of items used in the Group Allocation boxes is controlled by this number.

Range

G ≥ 2.
Group Allocation Input Type (when Solve For = Power)

Specify how you want to enter the information about how the subjects are allocated to each of the G groups. Possible options are:

- **Equal (n1 = n2 = ... = nG = n)**
  
  The sample size of every group is n. All group sample sizes are equal. Enter one or more values for n.

- **Enter group multipliers and n**
  
  Enter a list of group multipliers (r1, r2, ..., rG) and one or more values of n. The individual group sample sizes are found by multiplying the multipliers by n. For example, n1 = r1 x n.

- **Enter n1, n2, ..., nG**
  
  Enter a list of group sample sizes, one for each group.

- **Enter columns of ni's**
  
  Select one or more columns of the spreadsheet that each contain a set of group sample sizes going down the column. Each column is analyzed separately.

**n (Sample Size Per Group)**

Enter n, the number of subjects in each group. The total number of subjects, N, is equal to n x (number of groups). You can specify a single value or a list.

- **Single Value**
  
  Enter a value for the sample size of all groups. If you enter '10' here and there are five groups, then each group will be assigned 10 subjects and the total sample size will be 50.

- **List of Values**
  
  A separate power analysis is calculated for each value of n in the list. All analyses assume that the common, group sample size is n.

**Range of n**

n > 1

**Group Multipliers (r1, r2, ..., rG)**

Enter a set of G multipliers, one for each group.

The individual group sample sizes is computed as ni = ceiling[ri x n], where ceiling[y] is the first integer greater than or equal to y. For example, the multipliers {1, 1, 2, 2.95} and base n of 10 would result in the sample sizes {10, 10, 20, 30}.

**Incomplete List**

If the number of items in the list is less than G, the missing multipliers are set equal to the last entry in the list.

**Range**

The items in the list must be positive. The resulting sample sizes must be at least 1.
**n (Base Sample Size Per Group)**

Enter \( n \), the base number of subjects in each group. The number of subjects in the group is found by multiplying this number by the corresponding group multiplier, \( \{r_1, r_2, \ldots, r_G\} \), and rounding up to the next integer.

You can specify a single value or a list.

**Single Value**

Enter a value for the base group sample size.

**List of Values**

A separate power analysis is calculated for each value of \( n \) in the list.

**Range**

Ceiling\( [n \times r_i] \geq 1 \).

\( n_1, n_2, \ldots, n_G \) (List)

Enter a list of \( G \) sample sizes, one for each group.

**Incomplete List**

If the number of items in the list is less than \( G \), the missing sample sizes are set equal to the last entry in the list.

**Range**

The items in the list must be positive. At least one item in the list must be greater than 1.

**Columns of \( n_i \)'s**

Enter one or more spreadsheet columns containing vertical lists of group sample sizes.

Press the Spreadsheet icon (directly to the right) to select the columns and then enter the values.

Press the Input Spreadsheet icon (to the right and slightly up) to view/edit the spreadsheet. Also note that you can obtain the spreadsheet by selecting "Tools", then "Input Spreadsheet", from the menus.

On the spreadsheet, the group sample sizes are entered going down.

**Examples (assuming \( G = 3 \))**

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>C1</td>
<td>C2</td>
<td>C3</td>
</tr>
<tr>
<td>111</td>
<td>1</td>
<td>28</td>
</tr>
<tr>
<td>115</td>
<td>20</td>
<td>68</td>
</tr>
<tr>
<td>100</td>
<td>30</td>
<td>46</td>
</tr>
</tbody>
</table>

**Definition of a Single Column**

Each column gives one list. Each column results in a new scenario. The columns are not connected, but all should have exactly \( G \) rows.

Each entry in the list is the sample size of that group.

**Incomplete List**

If the number of items in the list is less than \( G \), the missing entries are set equal to the last entry in the list.

**Valid Entries**

All values should be positive integers. At least one value must be greater than one.
Note
The column names (C1, C2, ...) can be changed by clicking on them in the spreadsheet.

**Group Allocation Input Type (when Solve For = Sample Size)**
Specify how you want to enter the information about how the subjects are allocated to each of the G groups.

Options

- **Equal** \(n_1 = n_2 = \ldots = n_G = n\)
  All group sample sizes are equal to \(n\). The value of \(n\) will be found by conducting a search.

- **Enter group allocation pattern**
  Enter an allocation pattern \((r_1, r_2, \ldots, r_G)\). The pattern consists of a set of \(G\) numbers. These numbers will be rescaled into proportions by dividing each item by the sum of all items. The individual group sample sizes are found by multiplying these proportions by \(N\) (the total sample size) and rounding up.

- **Enter columns of allocation patterns**
  Select one or more columns of the spreadsheet that each contain a group allocation pattern going down the column. Each column is analyzed separately.

**Group Allocation Pattern** \((r_1, r_2, \ldots, r_G)\)
Enter an allocation pattern \((r_1, r_2, \ldots, r_G)\). The pattern consists of a set of \(G\) numbers. These numbers will be rescaled into proportions of total sample size by dividing each item by the sum of all items. The individual group sample sizes are found by multiplying these proportions by \(N\) (the total sample size) and rounding up.

For example, the pattern \(\{1, 3, 4\}\) will be rescaled to \(\{0.125, 0.375, 0.5\}\). The group sample sizes will be constrained to these proportions (within rounding) during the search for the sample configuration that just meets the power requirement.

**Incomplete List**
If the number of items in the list is less than \(G\), the missing numbers are set equal to the last entry in the list.

**Range**
The items in the list must be positive. The resulting sample sizes must be at least 1.

**Columns of Group Allocation Patterns**
Enter one or more spreadsheet columns containing vertical lists of group allocation patterns.

Press the Spreadsheet icon (directly to the right) to select the columns and then enter the values.

Press the Input Spreadsheet icon (to the right and slightly up) to view/edit the spreadsheet. Also note that you can obtain the spreadsheet by selecting "Tools", then "Input Spreadsheet", from the menus.

On the spreadsheet, the group allocation patterns are entered going down.

**Examples (assuming \(G = 3\))**
\[
\begin{array}{ccc}
  C1 & C2 & C3 \\
  1 & 1 & 3 \\
  1 & 2 & 3 \\
  3 & 2 & 1 \\
\end{array}
\]
Definition of a Single Column
Each column gives one allocation pattern. Each column results in a new scenario. The columns are not connected, but all should have exactly G rows.

Incomplete List
If the number of items in a list is less than G, the missing numbers are set equal to the last entry in the list before they are rescaled.

Valid Entries
All values should be positive numbers. You can enter decimal values.

Note
The column names (C1, C2, ...) can be changed by clicking on them in the spreadsheet

Measurement Times Schedule

Measurement Time Input Type
Specify how you want to enter the information about the measurement proportion times.

- Equally Spaced Measurement Times
  Enter one or more values for M, the number of measurements per subject. Equally-spaced measurement time proportions will automatically be generated.

- List of Measurement Time Proportions
  Enter a list of measurement time proportions in the box below, one for each time point. The number of measurement times, M, is set equal to the number of items in this list.

- Columns of Measurement Time Proportions
  Select one or more columns of the spreadsheet that contain a set of measurement time proportions. Each column is analyzed separately. The number of measurement times, M, is equal to the number of rows in the active column.

M (Measurements)
Specify one or more values for M, the total number of measurements scheduled for each subject. It is assumed that these measurements are made at identical time points or under the same conditions.

At least one value must be entered. If multiple values are entered, a separate analysis is run for each value.

The value must be an integer greater than 1. A reasonable range is from 2 to 50.

Some examples are
3
3 4 5
3 to 10 by 1

Measurement Time Proportions
Enter a set of measurement time proportions, one for each time point. The number of measurements, M, is the number of items in the list. Each entry in the list is the proportion that that time is of the maximum time.

For example, suppose a 24-month study is planned with anticipated measurements at the beginning and then after each six-month period. Hence, the five measurement times are 0, 6, 12, 18, and 24 months. The entry must be proportions of 24, so the actual entry would be ‘0, 0.25, 0.50, 0.75, 1.0’.
M, the number of repeated measurements, is set to the number of items in the list. Once M is set here, it must match its implicit value in the Correlations and Missing Proportions.

**Auto Rescaling**
You can enter any increasing series that is convenient and it will be rescaled so that each entry is a proportion of the maximum. In the example above, you could have entered ‘0, 6, 12, 18, 24’ or even ‘1, 2, 3, 4, 5’ and the program would have rescaled the values into proportions beginning at 0 and ending at 1.

**Valid Entries**
Since the numbers are automatically rescaled, the only requirement is that the series be strictly increasing.

**Examples**
0 0.25 0.50 0.75 1.0
0 10 50 90 100
0 0.20 0.40 0.90 0.95 1.0
1 2 3 4 5
0 10 20 40

**Column(s) of Time Proportions**
Enter one or more spreadsheet columns containing lists of measurement time proportions.
Press the Spreadsheet icon (directly to the right) to select the columns and then enter the values. Press the Input Spreadsheet icon (to the right and slightly up) to view/edit the spreadsheet. Also note that you can obtain the spreadsheet by selecting Tools, then Input Spreadsheet, from the menus. On the spreadsheet, the measurement times are entered going down.

**Examples**
C1 C2 C3
0.0 1 0.1
0.2 2 0.4
0.4 3 0.5
0.6 4
0.8
1.0

**Definition of a Single Column**
Each column gives one list of time proportions. Each column results in a new scenario. Different columns are not connected and may be of different lengths.
Each entry in the list is the proportion that that time is of the maximum time. For example, suppose a 24-month study is planned with anticipated measurements at the beginning and then after each six-month period. Hence, the five measurement times are 0, 6, 12, 18, and 24 months. The entry must be proportions of 24, so the actual entry would be ‘0, 0.25, 0.50, 0.75, 1.0’ (entered vertically in a particular column).

**Auto Rescaling**
You can enter any increasing series that is convenient and it will be rescaled so that each entry is a proportion of the maximum. In the example above, you could have entered ‘0 6 12 18 24’, or even ‘1 2 3 4 5’, going down the column and the program would have rescaled the values into proportions beginning at 0 and ending at 1.

**Valid Entries**
Since the numbers are automatically rescaled, the only requirement is that the series be strictly increasing.
Notes
M, the number of repeated measurements, is set to the number of items in the active column.

Once M is set here, it must match its implicit value in the Correlations and Missing Proportions.

The column names (C1, C2, ...) can be changed by clicking on them in the spreadsheet.

Effect Size

μi's Input Type
Specify how you want to enter μ1, μ2, ..., μG, the mean time-averaged response per group for each of the G groups.

Options

• μ1, μ2, ..., μG
  Specify the values of the mean time-averaged response for each group. The differences among these values represent the effect size that you want to detect.

• Columns Containing Sets of μi's
  Select one or more columns of the spreadsheet that each contain a set of μi's going down the column. Each column is analyzed separately.

μ1, μ2, ..., μG
Enter the values of the mean time-averaged response for each of the G groups under the alternative hypothesis. The effect size that the study will detect is a function of the differences among these values.

A time-averaged response for a particular individual is the average of all of the repeated measurements of that individual. This value is the anticipated mean of all subjects in a particular group.

Range
Each μi should be numeric and at least one of the values must be different from the rest.

Example
10 10 10 40

Incomplete List
If the number of items in a list is less than G, the missing numbers are set equal to the last entry.

Columns Containing Sets of μi's
Enter one or more spreadsheet columns containing vertical lists of μ1, μ2, ..., μG.

Press the Spreadsheet icon (directly to the right) to select the columns and then enter the values.

Press the Input Spreadsheet icon (to the right and slightly up) to view/edit the spreadsheet. Also note that you can obtain the spreadsheet by selecting "Tools", then "Input Spreadsheet", from the menus.

On the spreadsheet, the μi’s are entered going down.
Examples (assuming G = 3)

<table>
<thead>
<tr>
<th></th>
<th>C1</th>
<th>C2</th>
<th>C3</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>10</td>
<td>10</td>
<td>30</td>
</tr>
<tr>
<td>2</td>
<td>10</td>
<td>20</td>
<td>30</td>
</tr>
<tr>
<td>3</td>
<td>30</td>
<td>20</td>
<td>10</td>
</tr>
</tbody>
</table>

**Definition of a Single Column**

Each column gives one set of means. Each column results in a new scenario. The columns are not connected, but all should have exactly G rows.

**Incomplete List**

If the number of items in a list is less than G, the missing numbers are set equal to the last entry in the list.

**Valid Entries**

You can enter any numeric value.

**Note**

The column names (C1, C2, ...) can be changed by clicking on them in the spreadsheet.

**σ (Standard Deviation)**

Enter a value (or range of values) for the standard deviation of the response, Yij where i is the subject and j is the repeated measurement of that subject. The analysis assumes that this standard deviation is constant across all subjects.

These values must be positive.

You can enter a single value such as ‘10’ or a series of values such as ‘10 20 30 40 50’ or ‘1 to 5 by 0.5’.

**Pattern of ρ's Across Time (or Space)**

Specify the type of pattern for the ρ's, the correlations between responses of an individual at two points in time or between subjects within a cluster. This pattern often depends on the measurement time proportions. Usually, the correlation shrinks as two points are further and further apart in time. The options are

- **Compound Symmetry (All ρ's Equal)**

  A single value of ρ is used for all correlations.

  \[
  \begin{bmatrix}
  1 & \rho & \rho & \rho \\
  \rho & 1 & \rho & \rho \\
  \rho & \rho & 1 & \rho \\
  \rho & \rho & \rho & 1 \\
  \end{bmatrix}
  \]

  Example first row of correlation matrix

  \[1.0000, 0.5000, 0.5000, 0.5000, 0.5000, 0.5000\]
• **Banded (1 Time Period)**
  This is similar to all ρ's equal, except that all elements are set to zero after the first off-diagonal element.
  \[
  \begin{bmatrix}
  1 & \rho & 0 & 0 \\
  \rho & 1 & \rho & 0 \\
  0 & \rho & 1 & \rho \\
  0 & 0 & \rho & 1 \\
  \end{bmatrix}
  \]
  Example first row of correlation matrix
  1.0000, 0.5000, 0.0000, 0.0000, 0.0000

• **Banded (2 Time Periods)**
  This is similar to all ρ's equal, except that all elements are set to zero after the second off-diagonal element.
  \[
  \begin{bmatrix}
  1 & \rho & \rho & 0 \\
  \rho & 1 & \rho & \rho \\
  \rho & \rho & 1 & \rho \\
  0 & \rho & \rho & 1 \\
  \end{bmatrix}
  \]
  Example first row of correlation matrix
  1.0000, 0.5000, 0.5000, 0.0000, 0.0000, 0.0000

• **AR1 (Traditional) 1st Order Autocorrelation**
  A single value of ρ is used to generate a first order autocorrelation pattern in the correlation matrix. This pattern produces the autocorrelation at each successive step by multiplying the value at the last step by ρ. The basic formula is \( \rho_{jk} = \rho^{|j-k|} \). Thus the pattern is \( \rho, \rho^2, \rho^3, \) etc.
  \[
  \begin{bmatrix}
  1 & \rho & \rho^2 & \rho^3 \\
  \rho & 1 & \rho & \rho^2 \\
  \rho^2 & \rho & 1 & \rho \\
  \rho^3 & \rho^2 & \rho & 1 \\
  \end{bmatrix}
  \]
  Example first row of correlation matrix
  1.0000, 0.5000, 0.2500, 0.1250, 0.0625, 0.03125

• **AR1 (Proportional)**
  A single value of ρ is used to generate a first order autocorrelation pattern in the correlation matrix. This pattern produces the autocorrelation at each successive step by multiplying the value at the last step by ρ. The basic formula is \( \rho_{jk} = \rho^{|t_j-t_k|} \), where \( t_j \) and \( t_k \) are time proportions at which measurements are planned. An example is
  \[
  \begin{bmatrix}
  \rho^{03} & \rho^{13} & \rho^{23} & \rho^{33} \\
  \rho^{13} & \rho^{03} & \rho^{13} & \rho^{23} \\
  \rho^{23} & \rho^{13} & \rho^{03} & \rho^{13} \\
  \rho^{33} & \rho^{23} & \rho^{13} & \rho^{03} \\
  \end{bmatrix}
  \]
  Example first row of correlation matrix when \( M = 6 \) and \( \rho = 0.1 \). Note that ρ shows up at the end of the list in this case.
  1.0000, 0.6310, 0.3981, 0.2512, 0.1585, 0.1000
• **Dampened Exponential (Traditional)**
  This pattern is similar to the AR(1), except that the exponents are raised to the power of a second parameter which we label as Dexp. The formula is $\rho_{jk} = \rho^{|j-k|^D_{exp}}$.

  Example first row of correlation matrix with Dexp = 1.1
  
  $1.0000, 0.5000, 0.2012, 0.0729, 0.0245, 0.0078$

• **Dampened Exponential (Proportional)**
  A single value of $\rho$ is used to generate a first order autocorrelation pattern in the correlation matrix. This pattern produces the autocorrelation at each successive step by multiplying the value at the last step by $\rho$. The basic formula is $\rho_{jk} = \rho^{|t_j-t_k|^D_{exp}}$, where $t_j$ and $t_k$ are time proportions at which measurements are planned. An example with Dexp = 1 is

  $|\rho^0 \rho^1 \rho^2 \rho^3|
  
  |\rho^1 \rho^0 \rho^1 \rho^2|
  
  |\rho^2 \rho^1 \rho^0 \rho^1|
  
  |\rho^3 \rho^2 \rho^1 \rho^0|

  Example first row of correlation matrix when M = 6, $\rho = 0.1$, and Dexp = 1. Note that $\rho$ shows up at the end of the list in this case.

  $1.0000, 0.6310, 0.3981, 0.2512, 0.1585, 0.1000$

• **Linear Exponential Decay**
  This pattern is similar to AR(1). The formula is $\rho_{jk} = \rho^{|t_j/P-P_t/k/P|*E_{max}}$. $P$ is called the Base Time Proportion. The exponents of $\rho$ range from 1 at $P$ to $E_{max}$ at $M$.

  Example first row of correlation matrix with $E_{max} = 4$

  $1.0000, 0.5000, 0.2973, 0.1768, 0.1051, 0.0625$

  This pattern is particularly useful when you want to compare different values of $M$ since the exponent only depends on the difference. That is, a difference of 0.10 in the time proportions will always result in the same exponent, no matter what the value of $M$. This is NOT the case for AR(1).

• **Matrix on Spreadsheet**
  A symmetric matrix is entered in the spreadsheet. The number of columns selected must match $M$, the number of time periods.

**$\rho$ Pattern = Compound Symmetry, Banded (1 Time Period), Banded (2 Time Periods), AR(1)**

**$\rho$ (Base Correlation)**
This is the base correlation, $\rho$, between measurements on the same subject taken at two time points. In several cases, this value is modified according to a special formula.

At least one value must be entered. If multiple values are entered, a separate analysis is performed for each value.

**Range**
$0 < \rho < 1$ (negative values are not used). A value near 0 indicates low correlation. A value near 1 indicates high correlation.

**Recommended**
The value of this parameter depends on time or location pattern at which measurements are taken. In their book on sample size, Machin and Campbell comment that values between 0.60 and 0.75 are typical. Some authors recommend using 0.2 when nothing is known about the actual value.
Examples
0.5
0.5 0.6 0.7
0 to 0.9 by 0.1

\textbf{p Pattern = Damped Exponential}

\textbf{p (Base Correlation)}
This is the base correlation, $\rho$, between measurements on the same subject taken at two time points. In several cases, this value is modified according to a special formula.

At least one value must be entered. If multiple values are entered, a separate analysis is performed for each value.

\textbf{Range}
$0 < \rho < 1$ (negative values are not used). A value near 0 indicates low correlation. A value near 1 indicates high correlation.

\textbf{Recommended}
The value of this parameter depends on time or location pattern at which measurements are taken. In their book on sample size, Machin and Campbell comment that values between 0.60 and 0.75 are typical. Some authors recommend using 0.2 when nothing is known about the actual value.

Examples
0.5
0.5 0.6 0.7
0 to 0.9 by 0.1

\textbf{Dexp (Dampening Exponent)}
This exponent is applied to the AR(1) formula so that the resulting correlations are reduced faster. The formula become $\rho_{jk} = \rho^{\lvert j-k \rvert Dexp}$.

\textbf{Range}
The valid range is $Dexp > 0$. The typical range is 1 to 3.

\textbf{p Pattern = Linear Exponential Decay}

\textbf{p (Base Correlation)}
This is the base correlation, $\rho$, between measurements on the same subject taken at two time points. In several cases, this value is modified according to a special formula.

At least one value must be entered. If multiple values are entered, a separate analysis is performed for each value.

\textbf{Range}
$0 < \rho < 1$ (negative values are not used). A value near 0 indicates low correlation. A value near 1 indicates high correlation.

\textbf{Recommended}
The value of this parameter depends on time or location pattern at which measurements are taken. In their book on sample size, Machin and Campbell comment that values between 0.60 and 0.75 are typical. Some authors recommend using 0.2 when nothing is known about the actual value.
Examples
0.5
0.5 0.6 0.7
0 to 0.9 by 0.1

**Base Time Proportion**
The base time proportion is used by the Linear Exponential Decay formula to specify the time proportion at which the correlation exponent is one. Thus, at this proportion the base correlation is reproduced.

**Range**
0 < Time < 0.5.

**Typical Value**
1/M

**Note**
When you are comparing values of M, choose a value for M near the smallest value of 1/M.

**Emax (Max Decay Exponent)**
This specifies the exponent of the base correlation when the time proportion is 1. Thus, the exponents go linearly from 1 at the base time to Emax at the maximum time.

**Range**
Emax > 0.

**Typical**
Typical values of Emax are between 1 and 10.

**p Pattern = Matrix on Spreadsheet**

**Columns Containing the pjk's**
Select a set of M columns from the spreadsheet that contain a correlation matrix. Each column represents a column of the correlation matrix so it must contain M rows.

Since this is a correlation matrix, the diagonal elements must be set to one and the absolute values of the off-diagonal elements must be less than one. Also, the matrix must be symmetric.

**Missing Proportions Across Measurement Times**

**Missing Input Type**
Specify the way in which you want to specify the pattern of missing values.

Each missing value pattern is a list of missing proportions at each of the M time points. Each value in the list must be non-negative and less than 1.

Possible input choices are

- **Constant = 0**
  All missing proportions are set to 0. That is, there are no missing values.

- **Constant**
  All missing proportions are set to constant value.
• **Piecewise Constant on Spreadsheet**
  A set of missing proportions are defined for several time intervals using the spreadsheet. One column contains the missing proportions for the interval, going down the rows. Another column defines the corresponding upper limit of time proportion of the interval. The lower limit is implied by the limit given immediately above. The program assumes that the first time interval starts at 0 percent.

• **Linear (Steady Change)**
  The missing proportions fall along a straight-line between 0 and 1 elapsed time. Only the first and last proportions are entered.

• **Piecewise Linear on Spreadsheet**
  The missing proportions fall along a set of connected straight-lines that are defined by two columns on the spreadsheet.

• **List**
  Enter a list of M missing proportions, one for each time point.

• **Multiple Lists on Spreadsheet**
  Select multiple columns containing vertical lists of missing proportions. Each column contains a set of missing proportions in rows, one for each time point.

• **Pairwise Observed Proportions on Spreadsheet**
  Enter an M x M matrix of observant probabilities by selecting M columns. These observant probabilities are the proportion of the responses for both the row and column time points that are observed.

**Missing Input Type = Constant Additional Options**

**Constant Missing Proportion**
Enter one or more values of the missing value proportion that is to be used for all time points.
If multiple values are entered, a separate analysis is performed for each value.

**Range**
0 ≤ Missing Proportion < 1.

**Examples**
0.2
0.1 0.2 0.4
0 to 0.4 by 0.1

**Missing Input Type = Piecewise Constant on Spreadsheet Additional Options**

**Pairwise Missing Pattern**
See the Pairwise Missing Pattern section of above.

**Column of Missing Proportions (Pairwise)**
Enter the column name on the spreadsheet containing a column of missing proportions, one for each segment. The program assigns this missing proportion to all time points in this time segment. The number of segments is arbitrary and determined by the number of rows.

Note that the usual pattern is to have the missing proportions increase over time.
Press the Spreadsheet icon (directly to the right) to select the column and then enter the missing proportion values.

Press the Input Spreadsheet icon (to the right and slightly up) to view/edit the spreadsheet. Note that you can obtain also the spreadsheet window by selecting "Tools", then "Input Spreadsheet", from the menus.

(Pairwise)
This refers to the two types of pairwise missing patterns: Ind(ependent) and Mon(otonic).

Example
Suppose that 'C1' is selected for the Missing column and 'C2' is selected for the Time column. Suppose that these columns contain the following values:

<table>
<thead>
<tr>
<th>C1</th>
<th>C2</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.1</td>
<td>0.2</td>
</tr>
<tr>
<td>0.3</td>
<td>0.5</td>
</tr>
<tr>
<td>0.35</td>
<td>0.75</td>
</tr>
<tr>
<td>0.4</td>
<td>0.9</td>
</tr>
<tr>
<td>0.6</td>
<td>1.0</td>
</tr>
</tbody>
</table>

This would be interpreted by the program as

<table>
<thead>
<tr>
<th>Time Interval</th>
<th>Missing</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 ≤ t ≤ 0.2</td>
<td>0.1</td>
</tr>
<tr>
<td>0.2 &lt; t ≤ 0.5</td>
<td>0.3</td>
</tr>
<tr>
<td>0.5 &lt; t ≤ 0.75</td>
<td>0.35</td>
</tr>
<tr>
<td>0.75 &lt; t ≤ 0.9</td>
<td>0.4</td>
</tr>
<tr>
<td>0.9 &lt; t ≤ 1.0</td>
<td>0.6</td>
</tr>
</tbody>
</table>

Column of Time Proportions (Pairwise)
Enter the column name on the spreadsheet containing a column of Upper Limit Time Proportions, one for each segment. The program assigns the missing proportion to all time points in the time segment defined by this upper limit. The number of segments is arbitrary and determined by the number of rows. Note that the final upper limit must be 1.

Press the Spreadsheet icon (directly to the right) to select the column and then enter the missing proportion values.

Press the Input Spreadsheet icon (to the right and slightly up) to view/edit the spreadsheet. Note that you can obtain also the spreadsheet window by selecting "Tools", then "Input Spreadsheet", from the menus.

(Pairwise)
This refers to the two types of pairwise missing patterns: Ind(ependent) and Mon(otonic).

Example
Suppose that 'C1' is selected for the Missing column and 'C2' is selected for the Time column. Suppose that these columns contain the following values:

<table>
<thead>
<tr>
<th>C1</th>
<th>C2</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.1</td>
<td>0.2</td>
</tr>
<tr>
<td>0.3</td>
<td>0.5</td>
</tr>
<tr>
<td>0.35</td>
<td>0.75</td>
</tr>
<tr>
<td>0.4</td>
<td>0.9</td>
</tr>
<tr>
<td>0.6</td>
<td>1.0</td>
</tr>
</tbody>
</table>
This would be interpreted by the program as

<table>
<thead>
<tr>
<th>Time Interval</th>
<th>Missing</th>
</tr>
</thead>
<tbody>
<tr>
<td>(0 \leq t \leq 0.2)</td>
<td>0.1</td>
</tr>
<tr>
<td>(0.2 &lt; t \leq 0.5)</td>
<td>0.3</td>
</tr>
<tr>
<td>(0.5 &lt; t \leq 0.75)</td>
<td>0.35</td>
</tr>
<tr>
<td>(0.75 &lt; t \leq 0.9)</td>
<td>0.4</td>
</tr>
<tr>
<td>(0.9 &lt; t \leq 1.0)</td>
<td>0.6</td>
</tr>
</tbody>
</table>

**Missing Input Type = Linear (Steady Change) Additional Options**

**Pairwise Missing Pattern**

See the Pairwise Missing Pattern section of above.

**First (or Last) Missing Proportion (Pairwise)**

Specify a set of \(M\) missing proportions by entering only the first and last values of the list. A straight-line formula will be used to calculate the missing proportions for each time point in the interval.

**Range**

\(0 \leq \text{First} \leq \text{Last}\)

\(\text{First} \leq \text{Last} < 1\)

**Example**

Suppose a study is being planned with 5, evenly spaced, measurements. Further suppose that the missing data proportions are anticipated to be 0.1 initially and increase to 0.6 at the end of the study, with the missing proportions in between arranged linearly. If \(M = 5\), First = 0.1, and Last = 0.6, then the resulting Missing Proportions will be 0.1, 0.225, 0.35, 0.475, and 0.60. Note that these proportions are evenly spaced between the two boundaries.

Note that using this option allows the value of \(M\) to be varied and reasonable comparisons in power and sample size to be made.

**Missing Input Type = Piecewise Linear on Spreadsheet Additional Options**

**Pairwise Missing Pairwise**

See the Pairwise Missing Pairwise section of above.

**Column of Missing (or Time) Proportions (Pairwise)**

These options let you easily define separate missing proportions for various time intervals of a study.

Select the column name on the spreadsheet of a column containing missing proportions. Also select the column name of the corresponding measurement time proportions. The program calculates a straight-line defined by each successive pair of points (see example below). This set of connected line segments becomes a prediction equation for the missing proportion based on the corresponding time proportion.

The number of line segments is arbitrary and determined from the number of rows in the selected columns. The number of rows does not have to match \(M\), the number of time points.

**(Pairwise)**

This designates which of the two types of pairwise missing patterns, Ind(ependent) or Mon(otonic), is being entered in this option.
Notes
The usual pattern is to for the missing proportions to increase over time. The time value of the first row of the time column must be 0. The time value of the last row of the time column must be 1.

Shortcuts
Press the Spreadsheet icon (directly to the right) to select the column and then enter the missing proportion values. Press the Input Spreadsheet icon (to the right and slightly up) to view/edit the spreadsheet. Note that you can obtain also the spreadsheet window by selecting "Tools", then "Input Spreadsheet", from the menus.

Example
Suppose that you have enter data in two columns on the spreadsheet labeled Miss and Time as follows.

<table>
<thead>
<tr>
<th>Miss</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.5</td>
<td>0</td>
</tr>
<tr>
<td>0.1</td>
<td>0.2</td>
</tr>
<tr>
<td>0.3</td>
<td>0.5</td>
</tr>
<tr>
<td>0.35</td>
<td>0.75</td>
</tr>
<tr>
<td>0.4</td>
<td>0.9</td>
</tr>
<tr>
<td>0.6</td>
<td>1</td>
</tr>
</tbody>
</table>

Now suppose that Miss is selected for the Missing column and Time is selected for the Time column. This would be interpreted by the program as the following segmented-prediction equation.

<table>
<thead>
<tr>
<th>Time Interval</th>
<th>Slope</th>
<th>Intercept</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 ≤ T ≤ 0.2</td>
<td>0.25</td>
<td>0.1-0.2*0.25 = 0.05</td>
</tr>
<tr>
<td>0.2 &lt; T ≤ 0.5</td>
<td>0.67</td>
<td>0.3-0.5*0.67 = -0.0333</td>
</tr>
<tr>
<td>0.5 &lt; T ≤ 0.75</td>
<td>0.33</td>
<td>0.4-0.5*.33 = 0.1</td>
</tr>
<tr>
<td>0.75 &lt; T ≤ 0.9</td>
<td>2</td>
<td>0.6-1*2 = -1.4</td>
</tr>
</tbody>
</table>

A Missing Proportion would then be calculated using the formula

\[ Missing = \text{Intercept} + \text{Slope} \times \text{Time} \]

For example, using the above values, the missing proportions at time points 0, 0.1, 0.3, 0.8, and 1.0 would be found as follows:

<table>
<thead>
<tr>
<th>Time</th>
<th>Equation</th>
<th>Resulting Missing Proportion</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0.05 + 0.25(0)</td>
<td>0.05</td>
</tr>
<tr>
<td>0.1</td>
<td>0.05 + 0.25(0.1)</td>
<td>0.075</td>
</tr>
<tr>
<td>0.3</td>
<td>-0.0333 + 0.67(0.3)</td>
<td>0.1667</td>
</tr>
<tr>
<td>0.8</td>
<td>0.1 + 0.33(0.8)</td>
<td>0.3667</td>
</tr>
<tr>
<td>1.0</td>
<td>-1.4 + 2(1)</td>
<td>0.6</td>
</tr>
</tbody>
</table>

**Missing Input Type = List Additional Options**

**Pairwise Missing Pairwise**
See the Pairwise Missing Pairwise section of above.

**List of Missing Proportions (Pairwise)**
These options let you easily define separate missing proportions for various time intervals of a study.

Select the column name on the spreadsheet of a column containing missing proportions. Also select the column name of the corresponding measurement time proportions. The program calculates a straight-line defined by each successive pair of points (see example below). This set of connected line segments becomes a prediction equation for the missing proportion based on the corresponding time proportion.
GEE Tests for the TAD of Multiple Groups in a Repeated Measures Design (Continuous Outcome)

**Missing Input Type = Multiple Lists on Spreadsheet Additional Options**

**Pairwise Missing Pairwise**
See the Pairwise Missing Pairwise section of above.

**Columns of Missing Proportions (Pairwise)**
Enter lists of missing value proportions by first entering them on the spreadsheet and then selecting those columns here. The missing value proportions are entered down the rows of a column, one for each time point. Each value is the anticipated proportion of missing responses at the corresponding time point.

Although you can enter any pattern you want, the usual pattern is that the proportion missing increases over time. When you specify more than \(M\) values in a list (where \(M\) is specified in the Measurement Times section), the extra values are ignored. When you specify too few values, the last value you specify is copied forward.

Press the Spreadsheet icon (directly to the right) to select the column and then enter the missing proportion values.

Press the Input Spreadsheet icon (to the right and slightly up) to view/edit the spreadsheet. Note that you can obtain also the spreadsheet window by selecting "Tools", then "Input Spreadsheet", from the menus.

**Range**
\[0 \leq \text{missing proportion} < 1.\]

**Missing Input Type = Pairwise Observed Proportions on Spreadsheet Additional Options**

**Columns of Pairwise Observed**
Enter an \(M\)-by-\(M\) matrix of pairwise observed proportions on the spreadsheet and then select it by selecting those \(M\) columns here. Each entry gives the proportion (or probability) that the corresponding row and column time point values are both observed (non-missing). The diagonal elements of this matrix contain the probability that an observation is observed at that point (marginal probability).

**Range**
\[0 < \text{each value} \leq 1.\]

**Note**
In other missing entries, you enter the proportion missing. This is the only case that requires the proportion observed.
Example 1 – Determining Sample Size

Researchers are planning a study comparing three heart-rate medications: a standard drug and two experimental drugs. The experimental drugs appear to have about the same impact on heart rate. Each subject will receive four doses of only one drug, two days apart. The researchers want a sample size large enough to detect a time-averaged difference of 5 between the highest and lowest time-averaged heart rates. They will use the means of 65, 60, and 60 to represent this difference.

Similar studies have had a standard deviation of the residuals within a subject across time of between 5 and 7. These studies also showed an autocorrelation between adjacent measurements on the same individual of 0.7, so they want to try values of 0.6, 0.7, and 0.8. The researchers assume that first-order autocorrelation adequately represents the autocorrelation pattern. The test will be conducted at the 0.05 significance level and powered at 90%. The subjects will be randomly split equally among the three groups.

The researchers anticipate that the missing pattern across time will begin at 0% missing and increase steadily to 20% at the fourth measurement. They assume that the pairwise missing is independent.

What are the sample size requirements for this study?

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the procedure window. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Power</td>
<td>0.90</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>G (Number of Groups)</td>
<td>3</td>
</tr>
<tr>
<td>Group Allocation Input Type</td>
<td>Equal (n1 = n2 = ... = nG = n)</td>
</tr>
<tr>
<td>Measurement Time Input Type</td>
<td>Equally Spaced Measurement Times</td>
</tr>
<tr>
<td>M (Number of Measurement Times)</td>
<td>4</td>
</tr>
<tr>
<td>μi's Input Type</td>
<td>μ1, μ2, ..., μG</td>
</tr>
<tr>
<td>μ1, μ2, ..., μG</td>
<td>65 60 60</td>
</tr>
<tr>
<td>σ (Standard Deviation)</td>
<td>5 6 7</td>
</tr>
<tr>
<td>Pattern of ρ's Across Time</td>
<td>AR1 (Traditional)</td>
</tr>
<tr>
<td>ρ (Base Correlation)</td>
<td>0.6 0.7 0.8</td>
</tr>
<tr>
<td>Missing Input Type</td>
<td>Linear (Steady Change)</td>
</tr>
<tr>
<td>Pairwise Missing Pattern</td>
<td>Independent (Ind)</td>
</tr>
<tr>
<td>First Missing Proportion (Ind)</td>
<td>0</td>
</tr>
<tr>
<td>Last Missing Proportion (Ind)</td>
<td>0.2</td>
</tr>
</tbody>
</table>
Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

### Numeric Results
- **Measurement Times:** Equally spaced
- **Correlation:** AR(1): $\rho_{ij} = \rho^{|i-j|}$
- **Missing Pattern:** Range of missing proportions
- **Observant Proportions:** Assume independence
- **Number of Groups:** 3

<table>
<thead>
<tr>
<th>Power</th>
<th>N</th>
<th>Group Alloc Prop Set</th>
<th>Meas Times</th>
<th>Time Ave Resp Set</th>
<th>SD of Grp Means of</th>
<th>Std Dev</th>
<th>Base Corr</th>
<th>First Row of Corr Matrix</th>
<th>Alpha</th>
<th>Miss Set</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.9060</td>
<td>36</td>
<td>ri(1)</td>
<td>4</td>
<td>T(1)</td>
<td>$\mu_i(1)$</td>
<td>2.36</td>
<td>5.00</td>
<td>0.6000</td>
<td>$p_1(1)$</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9131</td>
<td>42</td>
<td>ri(1)</td>
<td>4</td>
<td>T(1)</td>
<td>$\mu_i(1)$</td>
<td>2.36</td>
<td>5.00</td>
<td>0.7000</td>
<td>$p_2(1)$</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9148</td>
<td>48</td>
<td>ri(1)</td>
<td>4</td>
<td>T(1)</td>
<td>$\mu_i(1)$</td>
<td>2.36</td>
<td>5.00</td>
<td>0.8000</td>
<td>$p_3(1)$</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9012</td>
<td>51</td>
<td>ri(1)</td>
<td>4</td>
<td>T(1)</td>
<td>$\mu_i(1)$</td>
<td>2.36</td>
<td>6.00</td>
<td>0.6000</td>
<td>$p_1(1)$</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9109</td>
<td>60</td>
<td>ri(1)</td>
<td>4</td>
<td>T(1)</td>
<td>$\mu_i(1)$</td>
<td>2.36</td>
<td>6.00</td>
<td>0.7000</td>
<td>$p_2(1)$</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9015</td>
<td>66</td>
<td>ri(1)</td>
<td>4</td>
<td>T(1)</td>
<td>$\mu_i(1)$</td>
<td>2.36</td>
<td>6.00</td>
<td>0.8000</td>
<td>$p_3(1)$</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9118</td>
<td>72</td>
<td>ri(1)</td>
<td>4</td>
<td>T(1)</td>
<td>$\mu_i(1)$</td>
<td>2.36</td>
<td>7.00</td>
<td>0.6000</td>
<td>$p_1(1)$</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9085</td>
<td>81</td>
<td>ri(1)</td>
<td>4</td>
<td>T(1)</td>
<td>$\mu_i(1)$</td>
<td>2.36</td>
<td>7.00</td>
<td>0.7000</td>
<td>$p_2(1)$</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9020</td>
<td>90</td>
<td>ri(1)</td>
<td>4</td>
<td>T(1)</td>
<td>$\mu_i(1)$</td>
<td>2.36</td>
<td>7.00</td>
<td>0.8000</td>
<td>$p_3(1)$</td>
<td>0.050</td>
</tr>
</tbody>
</table>

**Set(Set Number): Values**
- $n(1): 0.333, 0.333, 0.333$
- $T(1): 0.00, 0.33, 0.67, 1.00$
- $\mu_i(1): 65.00, 60.00, 60.00$
- $p_1(1): 1.0000, 0.6000, 0.3600, 0.2160$
- $p_2(1): 1.0000, 0.7000, 0.4900, 0.3430$
- $p_3(1): 1.0000, 0.8000, 0.6400, 0.5120$
- Ms1(1): 0.00, 0.07, 0.13, 0.20

**References**

**Report Definitions**
- **Power** is the probability of rejecting a false null hypothesis.
- **N** is the total number of subjects in the study.
- 'Group Alloc Prop Set ri' gives the name of the set containing group allocation proportions.
- 'Meas Time M' is the number of time points at which each subject is scheduled to be measured.
- 'Time Set' gives the name of the set containing the time proportions. The time values represent the proportion of the total study time that has elapsed just before the measurement.
- 'Time-Ave Resp Set $\mu_i$' gives the name of the set containing the time-averaged responses for each group.
- 'SD of Grp Means $\sigma_m$' is the population standard deviation of the group means.
- $\sigma$ is the standard deviation of a response.
- $\rho$ is the base correlation between two responses on the same subject. It may be transformed based on the correlation pattern.
- 'First Row of Corr Matrix' presents the top row of the correlation matrix.
- **Alpha** is the significance level of the test. The probability of rejecting the null hypothesis when the null hypothesis is true.
- 'Miss Set' gives the name of the set containing the missing value proportions across time.
Summary Statements
A total sample of 36 subjects, divided among 3 groups and each measured 4 times, achieve a power of 0.9060 when using a Chi-squared test with 2 degrees of freedom from a GEE analysis to determine whether the group time-averaged responses differ significantly at a significance level of 0.050. The group sample sizes are 12, 12, 12. The group averages under the alternative hypothesis are 65.00, 60.00, 60.00. The residual standard deviation is anticipated to be 5.00. The measurements of each subject will be made at the following times expressed as proportions of the total study time: 0.00, 0.33, 0.67, 1.00. Missing values are assumed to occur completely at random (MCAR). These missing value proportions will be combined to form the pairwise observant probabilities using the Independent method. The anticipated proportions missing at each measurement time are 0.00, 0.07, 0.13, 0.20. The first row of the autocorrelation matrix of the responses within a subject is assumed to be 1.0000, 0.6000, 0.3600, 0.2160. Other rows follow the same pattern.

This report gives the sample size for each value of the other parameters.

These charts show the relationship among the design parameters.

<table>
<thead>
<tr>
<th>Time</th>
<th>T(0.00)</th>
<th>T(0.33)</th>
<th>T(0.67)</th>
<th>T(1.00)</th>
</tr>
</thead>
<tbody>
<tr>
<td>T(0.00)</td>
<td>1.0000</td>
<td>0.6000</td>
<td>0.3600</td>
<td>0.2160</td>
</tr>
<tr>
<td>T(0.33)</td>
<td>0.6000</td>
<td>1.0000</td>
<td>0.6000</td>
<td>0.3600</td>
</tr>
<tr>
<td>T(0.67)</td>
<td>0.3600</td>
<td>0.6000</td>
<td>1.0000</td>
<td>0.6000</td>
</tr>
<tr>
<td>T(1.00)</td>
<td>0.2160</td>
<td>0.3600</td>
<td>0.6000</td>
<td>1.0000</td>
</tr>
</tbody>
</table>

These reports show the autocorrelation matrix for the indicated row of the report.
Example 2 – Finding the Power

Continuing with Example 1, the researchers want to determine the power corresponding to group sample sizes ranging from 5 to 40 for the middle values of the other parameters.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the procedure window. You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Design Tab</strong></td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>G (Number of Groups)</td>
<td>3</td>
</tr>
<tr>
<td>Group Allocation Input Type</td>
<td>Equal (n1 = n2 = ⋯ = nG = n)</td>
</tr>
<tr>
<td>n (Sample Size Per Group)</td>
<td>5 to 40 by 5</td>
</tr>
<tr>
<td>Measurement Time Input Type</td>
<td>Equally Spaced Measurement Times</td>
</tr>
<tr>
<td>M (Number of Measurement Times)</td>
<td>4</td>
</tr>
<tr>
<td>μi's Input Type</td>
<td>μ1, μ2, ..., μG</td>
</tr>
<tr>
<td>μi</td>
<td>65 60 60</td>
</tr>
<tr>
<td>σ (Standard Deviation)</td>
<td>6</td>
</tr>
<tr>
<td>Pattern of ρ's Across Time</td>
<td>AR1 (Traditional)</td>
</tr>
<tr>
<td>ρ (Base Correlation)</td>
<td>0.7</td>
</tr>
<tr>
<td>Missing Input Type</td>
<td>Linear (Steady Change)</td>
</tr>
<tr>
<td>Pairwise Missing Pattern</td>
<td>Independent (Ind)</td>
</tr>
<tr>
<td>First Missing Proportion (Ind)</td>
<td>0</td>
</tr>
<tr>
<td>Last Missing Proportion (Ind)</td>
<td>0.2</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

<table>
<thead>
<tr>
<th>Group Sample Sizes</th>
<th>Meas Times</th>
<th>Time- Ave</th>
<th>SD of</th>
<th>First Row of Corr</th>
<th>Power</th>
<th>N</th>
<th>ni</th>
<th>M</th>
<th>Time</th>
<th>Set</th>
<th>Resp Set</th>
<th>μ</th>
<th>σm</th>
<th>σ</th>
<th>ρ</th>
<th>Matrix</th>
<th>Alpha</th>
<th>Miss Set</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.3484</td>
<td>15 ni(1)</td>
<td>4 T(1)</td>
<td>μ(1)</td>
<td>2.36</td>
<td>6.00</td>
<td>0.7000</td>
<td>p1(1)</td>
<td>0.050</td>
<td>Ms1(1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.6255</td>
<td>30 ni(2)</td>
<td>4 T(1)</td>
<td>μ(1)</td>
<td>2.36</td>
<td>6.00</td>
<td>0.7000</td>
<td>p1(1)</td>
<td>0.050</td>
<td>Ms1(1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.8091</td>
<td>45 ni(3)</td>
<td>4 T(1)</td>
<td>μ(1)</td>
<td>2.36</td>
<td>6.00</td>
<td>0.7000</td>
<td>p1(1)</td>
<td>0.050</td>
<td>Ms1(1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.9109</td>
<td>60 ni(4)</td>
<td>4 T(1)</td>
<td>μ(1)</td>
<td>2.36</td>
<td>6.00</td>
<td>0.7000</td>
<td>p1(1)</td>
<td>0.050</td>
<td>Ms1(1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.9611</td>
<td>75 ni(5)</td>
<td>4 T(1)</td>
<td>μ(1)</td>
<td>2.36</td>
<td>6.00</td>
<td>0.7000</td>
<td>p1(1)</td>
<td>0.050</td>
<td>Ms1(1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.9939</td>
<td>90 ni(6)</td>
<td>4 T(1)</td>
<td>μ(1)</td>
<td>2.36</td>
<td>6.00</td>
<td>0.7000</td>
<td>p1(1)</td>
<td>0.050</td>
<td>Ms1(1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.9936</td>
<td>105 ni(7)</td>
<td>4 T(1)</td>
<td>μ(1)</td>
<td>2.36</td>
<td>6.00</td>
<td>0.7000</td>
<td>p1(1)</td>
<td>0.050</td>
<td>Ms1(1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.9976</td>
<td>120 ni(8)</td>
<td>4 T(1)</td>
<td>μ(1)</td>
<td>2.36</td>
<td>6.00</td>
<td>0.7000</td>
<td>p1(1)</td>
<td>0.050</td>
<td>Ms1(1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Set(Set Number): Values
ni(1): 5, 5, 5
ni(2): 10, 10, 10
ni(3): 15, 15, 15
ni(4): 20, 20, 20
ni(5): 25, 25, 25
ni(6): 30, 30, 30
ni(7): 35, 35, 35
ni(8): 40, 40, 40
T(1): 0.00, 0.33, 0.67, 1.00
μi(1): 65.00, 60.00, 60.00
ρ1(1): 1.0000, 0.7000, 0.4900, 0.3430
Ms1(1): 0.00, 0.07, 0.13, 0.20

Note that the horizontal axis is scaled according to the \( ni \) set index. Hence, 1 is for \( ni(1) \), 2 is for \( ni(2) \), and so on. The same is true for the \( μi \)'s and the Linear Miss in the subtitle.
Example 3 – Comparing Various Effect Sizes

Continuing with Examples 1 and 2, the researchers want to compare the various sets of mean time-averaged responses on the sample size. To do this, they will compare the four sets of means shown in the following table. The first row is the standard medication. The second and third rows give the anticipated response to the experimental medications.

The values in this table must be loaded into the spreadsheet.

Table of Four Sets of Time-Averaged Responses

<table>
<thead>
<tr>
<th>C1</th>
<th>C2</th>
<th>C3</th>
<th>C4</th>
</tr>
</thead>
<tbody>
<tr>
<td>65</td>
<td>65</td>
<td>65</td>
<td>65</td>
</tr>
<tr>
<td>60</td>
<td>61</td>
<td>62</td>
<td>63</td>
</tr>
<tr>
<td>60</td>
<td>61</td>
<td>62</td>
<td>63</td>
</tr>
</tbody>
</table>

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the procedure window. You may then make the appropriate entries as listed below, or open Example 3 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Power</td>
<td>0.90</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>G (Number of Groups)</td>
<td>3</td>
</tr>
<tr>
<td>Group Allocation Input Type</td>
<td>Equal (n1 = n2 = … = nG = n)</td>
</tr>
<tr>
<td>Measurement Time Input Type</td>
<td>Equally Spaced Measurement Times</td>
</tr>
<tr>
<td>M (Number of Measurement Times)</td>
<td>4</td>
</tr>
<tr>
<td>μi's Input Type</td>
<td>Columns containing sets of μi's</td>
</tr>
<tr>
<td>Columns Containing Sets of μi's</td>
<td>C1-C4</td>
</tr>
</tbody>
</table>

The above table must be entered into the spreadsheet and the column names changed to C1 – C4. Press the Input Spreadsheet icon to the right to view the spreadsheet.

σ (Standard Deviation) ……………… 6
Pattern of ρ's Across Time ….. AR1 (Traditional)
ρ (Base Correlation) ……………… 0.7
Missing Input Type ………… Linear (Steady Change)
Pairwise Missing Pattern ……… Independent (Ind)
First Missing Proportion (Ind) ……………… 0
Last Missing Proportion (Ind) ……………… 0.2
Output

Click the Calculate button to perform the calculations and generate the following output.

**Numeric Results**

<table>
<thead>
<tr>
<th>Measurement Times:</th>
<th>Equally spaced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Correlation:</td>
<td>AR(1): $p(j,k) = p^{</td>
</tr>
<tr>
<td>Missing Pattern:</td>
<td>Range of missing proportions</td>
</tr>
<tr>
<td>Observant Proportions:</td>
<td>Assume independence</td>
</tr>
<tr>
<td>Number of Groups:</td>
<td>3</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Group</th>
<th>Alloc Prop Set Times</th>
<th>Meas Times</th>
<th>Time-Ave Resp Set</th>
<th>SD of Grp Means</th>
<th>Std Dev</th>
<th>Base Corr</th>
<th>Power N</th>
<th>ri M Set Times Time Set Row Mean Set</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.9109</td>
<td>60 ri(1)</td>
<td>4 T(1)</td>
<td>C1(1)</td>
<td>2.36</td>
<td>6.00</td>
<td>0.7000</td>
<td>0.9109</td>
<td>60 ri(1)</td>
</tr>
<tr>
<td>0.9086</td>
<td>93 ri(1)</td>
<td>4 T(1)</td>
<td>C2(2)</td>
<td>1.89</td>
<td>6.00</td>
<td>0.7000</td>
<td>0.9086</td>
<td>93 ri(1)</td>
</tr>
<tr>
<td>0.9026</td>
<td>162 ri(1)</td>
<td>4 T(1)</td>
<td>C3(3)</td>
<td>1.41</td>
<td>6.00</td>
<td>0.7000</td>
<td>0.9026</td>
<td>162 ri(1)</td>
</tr>
<tr>
<td>0.9013</td>
<td>363 ri(1)</td>
<td>4 T(1)</td>
<td>C4(4)</td>
<td>0.94</td>
<td>6.00</td>
<td>0.7000</td>
<td>0.9013</td>
<td>363 ri(1)</td>
</tr>
</tbody>
</table>

**Set (Set Number): Values**

| ri(1): | 0.333, 0.333, 0.333 |
| T(1): | 0.00, 0.33, 0.67, 1.00 |
| C1(1): | 65.00, 60.00, 60.00 |
| C2(2): | 65.00, 61.00, 61.00 |
| C3(3): | 65.00, 62.00, 62.00 |
| C4(4): | 65.00, 63.00, 63.00 |
| ρ1(1): | 1.0000, 0.7000, 0.4900, 0.3430 |
| Ms1(1): | 0.00, 0.07, 0.13, 0.20 |

Note that the horizontal axis gives the index of the means footnotes. Thus, ‘1.0’ is column C1, ‘2.0’ is column C2, and so on.
Example 4 – Validation of Sample Size Calculation using Zhang and Ahn (2013)

Zhang and Ahn (2013) presents an example which we will use to validate this procedure. Their example uses G = 4, m = 3, σ = 1.43178, ρ = 0.45, α = 0.05, power = 0.9, compound symmetry correlation pattern, equal group sample sizes, missing proportions of 0.02, 0.14, 0.23, measurement times at 1 week, 3 weeks, and 6 weeks, and group means of 1.99, 1.99, 1.99, 1.0. The resulting sample size was computed as 108 (27 per group).

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the procedure window. You may then make the appropriate entries as listed below, or open Example 4 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Power</td>
<td>0.90</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>G (Number of Groups)</td>
<td>4</td>
</tr>
<tr>
<td>Group Allocation Input Type</td>
<td>Equal (n1 = n2 = ⋮ = nG = n)</td>
</tr>
<tr>
<td>Measurement Time Input Type</td>
<td>List of Measurement Time Proportions</td>
</tr>
<tr>
<td>Measurement Time Proportions</td>
<td>0 0.6 1</td>
</tr>
<tr>
<td>μ1, μ2, ..., μG</td>
<td>1.99 1.99 1.99 1</td>
</tr>
<tr>
<td>σ (Standard Deviation)</td>
<td>1.43178</td>
</tr>
<tr>
<td>Pattern of ρ's Across Time</td>
<td>Compound Symmetry (All ρ's Equal)</td>
</tr>
<tr>
<td>ρ (Base Correlation)</td>
<td>0.45</td>
</tr>
<tr>
<td>Missing Input Type</td>
<td>List</td>
</tr>
<tr>
<td>Pairwise Missing Pattern</td>
<td>Independent (Ind)</td>
</tr>
<tr>
<td>List of Missing Proportions (Ind)</td>
<td>0.02 0.14 0.23</td>
</tr>
</tbody>
</table>
Output

Click the Calculate button to perform the calculations and generate the following output.

<table>
<thead>
<tr>
<th>Power</th>
<th>N</th>
<th>Set</th>
<th>Alloc</th>
<th>Prop</th>
<th>Times</th>
<th>Meas</th>
<th>Time</th>
<th>Ave</th>
<th>Resp</th>
<th>Set</th>
<th>μi</th>
<th>σm</th>
<th>σρ</th>
<th>Matrix</th>
<th>Alpha</th>
<th>Miss</th>
<th>Set</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.9007</td>
<td>108</td>
<td>ri(1)</td>
<td>3</td>
<td>0.250, 0.250, 0.250, 0.250</td>
<td>0.00, 0.60, 1.00</td>
<td>μi(1): 1.99, 1.99, 1.99, 1.00</td>
<td>ρ1(1): 1.0000, 0.4500, 0.4500</td>
<td>Ms(1): 0.02, 0.14, 0.23</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Example 5 – Impact of Measurement Time Distribution

This example will investigate the impact of measurement time on power. It will compare the power of studies that are evenly spaced with those that take more measurements at the beginning of the study, near the middle of the study, and at the end of the study.

This example uses G = 4, M = 6, σ = 14.3, α = 0.05, and power = 0.9. The correlation pattern is Linear Exponential Decay with a base correlation of 0.8, Base Time Proportion of 0.20, and Emax set to 4. The missing input type is set to Linear from 0 to 30% and the pairwise missing assumption is independent. Group means are 5, 5, 7, 10. The per group sample size is 120.

The measurement times for five scenarios are given in the following table.

<table>
<thead>
<tr>
<th>Tm1</th>
<th>Tm2</th>
<th>Tm3</th>
<th>Tm4</th>
<th>Tm5</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0.20</td>
<td>0.60</td>
<td>0.10</td>
<td>0.10</td>
<td>0.45</td>
</tr>
<tr>
<td>0.40</td>
<td>0.70</td>
<td>0.20</td>
<td>0.20</td>
<td>0.50</td>
</tr>
<tr>
<td>0.60</td>
<td>0.80</td>
<td>0.30</td>
<td>0.80</td>
<td>0.55</td>
</tr>
<tr>
<td>0.80</td>
<td>0.90</td>
<td>0.40</td>
<td>0.90</td>
<td>0.60</td>
</tr>
<tr>
<td>1.00</td>
<td>1.00</td>
<td>1.00</td>
<td>1.00</td>
<td>1.00</td>
</tr>
</tbody>
</table>

Note that the measurements in Tm1 are evenly spaced, those in Tm2 are loaded near the end, those of Tm3 occur at the beginning, those of Tm4 occur only at the beginning and the end, and those of Tm5 occur mostly near the middle.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the procedure window. You may then make the appropriate entries as listed below, or open Example 5 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>G (Number of Groups)</td>
<td>4</td>
</tr>
<tr>
<td>Group Allocation Input Type</td>
<td>Equal (n1 = n2 = ⋮ = nG = n)</td>
</tr>
<tr>
<td>n (Sample Size Per Group)</td>
<td>120</td>
</tr>
<tr>
<td>Measurement Time Input Type</td>
<td>Columns of Measurement Time Proportions</td>
</tr>
<tr>
<td>Columns of Time Proportions</td>
<td>Tm1-Tm5</td>
</tr>
<tr>
<td>The above table must be entered into the spreadsheet and the column names changed to Tm1 – Tm5. Press the Input Spreadsheet icon to the right to view the spreadsheet.</td>
<td></td>
</tr>
<tr>
<td>μ's Input Type</td>
<td>μ1, μ2, ..., μG</td>
</tr>
<tr>
<td>μ1, μ2, ..., μG</td>
<td>5 5 7 10</td>
</tr>
<tr>
<td>σ (Standard Deviation)</td>
<td>14.3</td>
</tr>
<tr>
<td>Pattern of ρ's Across Time</td>
<td>Linear Exponential Decay</td>
</tr>
<tr>
<td>ρ (Base Correlation)</td>
<td>0.8</td>
</tr>
<tr>
<td>Base Time Proportion</td>
<td>0.2</td>
</tr>
<tr>
<td>Emax (Max Decay Exponent)</td>
<td>4</td>
</tr>
<tr>
<td>Missing Input Type</td>
<td>Linear (Steady Change)</td>
</tr>
<tr>
<td>Pairwise Missing Pattern</td>
<td>Independent (Ind)</td>
</tr>
</tbody>
</table>
Output

Click the Calculate button to perform the calculations and generate the following output.

<table>
<thead>
<tr>
<th>Power</th>
<th>N</th>
<th>ni(1)</th>
<th>M</th>
<th>Sample Sizes</th>
<th>Time Ave Resp</th>
<th>SD of Grp Means</th>
<th>Std Dev</th>
<th>Base Corr</th>
<th>First Row Corr</th>
<th>Matrix Alpha</th>
<th>Miss Set</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.8783</td>
<td>480</td>
<td>120</td>
<td>6</td>
<td>Tm1(1)</td>
<td>μ(1)</td>
<td>2.05</td>
<td>14.30</td>
<td>0.8000</td>
<td>0.050</td>
<td>Ms1(Tm1)</td>
<td></td>
</tr>
<tr>
<td>0.8629</td>
<td>480</td>
<td>120</td>
<td>6</td>
<td>Tm2(2)</td>
<td>μ(1)</td>
<td>2.05</td>
<td>14.30</td>
<td>0.8000</td>
<td>0.050</td>
<td>Ms1(Tm2)</td>
<td></td>
</tr>
<tr>
<td>0.8588</td>
<td>480</td>
<td>120</td>
<td>6</td>
<td>Tm3(3)</td>
<td>μ(1)</td>
<td>2.05</td>
<td>14.30</td>
<td>0.8000</td>
<td>0.050</td>
<td>Ms1(Tm3)</td>
<td></td>
</tr>
<tr>
<td>0.8867</td>
<td>480</td>
<td>120</td>
<td>6</td>
<td>Tm4(4)</td>
<td>μ(1)</td>
<td>2.05</td>
<td>14.30</td>
<td>0.8000</td>
<td>0.050</td>
<td>Ms1(Tm4)</td>
<td></td>
</tr>
<tr>
<td>0.8550</td>
<td>480</td>
<td>120</td>
<td>6</td>
<td>Tm5(5)</td>
<td>μ(1)</td>
<td>2.05</td>
<td>14.30</td>
<td>0.8000</td>
<td>0.050</td>
<td>Ms1(Tm5)</td>
<td></td>
</tr>
</tbody>
</table>

Set(Set Number): Values

| ni(1): 120, 120, 120, 120 |
| n(1): 5.00, 5.00, 7.00, 10.00 |
| p1(Tm1): 1.0000, 0.8890, 0.8767, 0.5724, 0.4842, 0.4096 |
| p1(Tm2): 1.0000, 0.5724, 0.5265, 0.4842, 0.4453, 0.4096 |
| p1(Tm3): 1.0000, 0.8698, 0.8000, 0.7358, 0.6767, 0.4096 |
| p1(Tm4): 1.0000, 0.8698, 0.8000, 0.4842, 0.4453, 0.4096 |
| p1(Tm5): 1.0000, 0.6490, 0.6224, 0.5969, 0.5724, 0.4096 |
| Ms1(Tm1): 0.00, 0.06, 0.12, 0.18, 0.24, 0.30 |
| Ms1(Tm2): 0.00, 0.18, 0.21, 0.24, 0.27, 0.30 |
| Ms1(Tm3): 0.00, 0.03, 0.06, 0.09, 0.12, 0.30 |
| Ms1(Tm4): 0.00, 0.03, 0.06, 0.24, 0.27, 0.30 |
| Ms1(Tm5): 0.00, 0.14, 0.15, 0.17, 0.18, 0.30 |
The horizontal axis, *Time Set*, gives the sequence number of the measurement columns. Thus, 1 is Tm1(1), 2 is Tm2(2), and so on.

The pattern Tm4 produces the highest power. Remember that Tm4 put the measurements at the beginning and the end, but none in the middle.

Patterns Tm2, Tm3, and Tm5 are nearly tied for achieving the low powers. Tm1, the equally-spaced measurement scenario, is near the top.
Example 6 – Entering a Correlation Matrix

This example will show how a correlation matrix can be loaded directly.
This example uses $G = 4$, $M = 4$, $\sigma = 14.3$, $\alpha = 0.05$, and power = 0.9. The missing input type will be set to Linear from 0 to 30% and the pairwise missing assumption is independent. Group means are 5, 5, 7, 10. The per group sample sizes range from 50 to 150. A correlation matrix (shown below) is available from a previous study.

Table of Correlations

<table>
<thead>
<tr>
<th></th>
<th>C1</th>
<th>C2</th>
<th>C3</th>
<th>C4</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.0000</td>
<td>0.7000</td>
<td>0.4900</td>
<td>0.3430</td>
<td></td>
</tr>
<tr>
<td>0.7000</td>
<td>1.0000</td>
<td>0.7000</td>
<td>0.4900</td>
<td></td>
</tr>
<tr>
<td>0.4900</td>
<td>0.7000</td>
<td>1.0000</td>
<td>0.7000</td>
<td></td>
</tr>
<tr>
<td>0.3430</td>
<td>0.4900</td>
<td>0.7000</td>
<td>1.0000</td>
<td></td>
</tr>
</tbody>
</table>

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the procedure window. You may then make the appropriate entries as listed below, or open Example 6 by going to the File menu and choosing Open Example Template.

Option | Value
--- | ---
Design Tab |  
Solve For | Power
Alpha | 0.05
$G$ (Number of Groups) | 4
Group Allocation Input Type | Equal ($n_1 = n_2 = \cdots = n_G = n$)
$n$ (Sample Size Per Group) | 50 to 150 by 10
Measurement Time Input Type | Equally Spaced Measurement Times
$M$ (Number of Measurement Times) | 4
$\mu$'s Input Type | $\mu_1$, $\mu_2$, ..., $\mu_G$
$\mu_1$, $\mu_2$, ..., $\mu_G$ | 5 5 7 10
$\sigma$ (Standard Deviation) | 14.3
Pattern of $\rho$'s Across Time | Matrix on Spreadsheet
Columns Containing the $p_{jk}$'s | C1-C4
You must enter the correlation table using the Spreadsheet icon to the right.
Missing Input Type | Linear (Steady Change)
Pairwise Missing Pattern | Independent (Ind)
First Missing Proportion (Ind) | 0
Last Missing Proportion (Ind) | 0.30
Output

Click the Calculate button to perform the calculations and generate the following output.

<table>
<thead>
<tr>
<th>Power</th>
<th>N</th>
<th>ni</th>
<th>Set</th>
<th>Time</th>
<th>Ave</th>
<th>SD of</th>
<th>First Row of Corr</th>
<th>Matrix</th>
<th>Alpha</th>
<th>Miss Set</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.4939</td>
<td>200</td>
<td>ni(1)</td>
<td>4</td>
<td>T(1)</td>
<td>μ(1)</td>
<td>σ(1)</td>
<td>p(1)</td>
<td>0.050</td>
<td>Ms1(1)</td>
<td></td>
</tr>
<tr>
<td>0.5770</td>
<td>240</td>
<td>ni(2)</td>
<td>4</td>
<td>T(1)</td>
<td>μ(1)</td>
<td>σ(1)</td>
<td>p(1)</td>
<td>0.050</td>
<td>Ms1(1)</td>
<td></td>
</tr>
<tr>
<td>0.6513</td>
<td>280</td>
<td>ni(3)</td>
<td>4</td>
<td>T(1)</td>
<td>μ(1)</td>
<td>σ(1)</td>
<td>p(1)</td>
<td>0.050</td>
<td>Ms1(1)</td>
<td></td>
</tr>
<tr>
<td>0.7160</td>
<td>320</td>
<td>ni(4)</td>
<td>4</td>
<td>T(1)</td>
<td>μ(1)</td>
<td>σ(1)</td>
<td>p(1)</td>
<td>0.050</td>
<td>Ms1(1)</td>
<td></td>
</tr>
<tr>
<td>0.7713</td>
<td>360</td>
<td>ni(5)</td>
<td>4</td>
<td>T(1)</td>
<td>μ(1)</td>
<td>σ(1)</td>
<td>p(1)</td>
<td>0.050</td>
<td>Ms1(1)</td>
<td></td>
</tr>
<tr>
<td>0.8178</td>
<td>400</td>
<td>ni(6)</td>
<td>4</td>
<td>T(1)</td>
<td>μ(1)</td>
<td>σ(1)</td>
<td>p(1)</td>
<td>0.050</td>
<td>Ms1(1)</td>
<td></td>
</tr>
<tr>
<td>0.8561</td>
<td>440</td>
<td>ni(7)</td>
<td>4</td>
<td>T(1)</td>
<td>μ(1)</td>
<td>σ(1)</td>
<td>p(1)</td>
<td>0.050</td>
<td>Ms1(1)</td>
<td></td>
</tr>
<tr>
<td>0.8874</td>
<td>480</td>
<td>ni(8)</td>
<td>4</td>
<td>T(1)</td>
<td>μ(1)</td>
<td>σ(1)</td>
<td>p(1)</td>
<td>0.050</td>
<td>Ms1(1)</td>
<td></td>
</tr>
<tr>
<td>0.9126</td>
<td>520</td>
<td>ni(9)</td>
<td>4</td>
<td>T(1)</td>
<td>μ(1)</td>
<td>σ(1)</td>
<td>p(1)</td>
<td>0.050</td>
<td>Ms1(1)</td>
<td></td>
</tr>
<tr>
<td>0.9327</td>
<td>560</td>
<td>ni(10)</td>
<td>4</td>
<td>T(1)</td>
<td>μ(1)</td>
<td>σ(1)</td>
<td>p(1)</td>
<td>0.050</td>
<td>Ms1(1)</td>
<td></td>
</tr>
<tr>
<td>0.9485</td>
<td>600</td>
<td>ni(11)</td>
<td>4</td>
<td>T(1)</td>
<td>μ(1)</td>
<td>σ(1)</td>
<td>p(1)</td>
<td>0.050</td>
<td>Ms1(1)</td>
<td></td>
</tr>
</tbody>
</table>

Set(Set Number): Values
- ni(1): 50, 50, 50, 50
- ni(2): 60, 60, 60, 60
- ni(3): 70, 70, 70, 70
- ni(4): 80, 80, 80, 80
- ni(5): 90, 90, 90, 90
- ni(6): 100, 100, 100, 100
- ni(7): 110, 110, 110, 110
- ni(8): 120, 120, 120, 120
- ni(9): 130, 130, 130, 130
- ni(10): 140, 140, 140, 140
- ni(11): 150, 150, 150, 150

T(1): 0.00, 0.33, 0.67, 1.00
- μ(1): 5.00, 5.00, 7.00, 10.00
- p(1): 1.0000, 0.7000, 0.4900, 0.3430
- Ms1(1): 0.00, 0.10, 0.20, 0.30
Note that the horizontal axis corresponds to the sequence number of the ni set. Hence, 1 is ni(1), 2 is ni(2), and so on.
Example 7 – Entering an Observant Probabilities Matrix

This example will show how an observant probabilities matrix can be loaded directly.

This example uses $G = 4$, $M = 4$, $\sigma = 14.3$, and $\alpha = 0.05$. The per group sample sizes range from 50 to 150. Group means are 5, 5, 7, 10. The correlation pattern will be Linear Exponential Decay with a base correlation of 0.8, Base Time Proportion of 0.1, and Emax set to 4.

The missing input type will be set to Matrix of Pairwise Missing.

Table of Observant Probabilities

<table>
<thead>
<tr>
<th>Row</th>
<th>C1</th>
<th>C2</th>
<th>C3</th>
<th>C4</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1.00</td>
<td>0.90</td>
<td>0.80</td>
<td>0.70</td>
</tr>
<tr>
<td>2</td>
<td>0.90</td>
<td>0.90</td>
<td>0.72</td>
<td>0.63</td>
</tr>
<tr>
<td>3</td>
<td>0.80</td>
<td>0.72</td>
<td>0.80</td>
<td>0.56</td>
</tr>
<tr>
<td>4</td>
<td>0.70</td>
<td>0.63</td>
<td>0.56</td>
<td>0.70</td>
</tr>
</tbody>
</table>

This table gives the pairwise observant probabilities. That is, each entry gives the probability of obtaining a response for both the row and column time points. For example, 0.63 is the probability of observing both the second response and the fourth response.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the procedure window. You may then make the appropriate entries as listed below, or open Example 7 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>$G$ (Number of Groups)</td>
<td>4</td>
</tr>
<tr>
<td>Group Allocation Input Type</td>
<td>Equal ($n_1 = n_2 = \cdots = n_G = n$)</td>
</tr>
<tr>
<td>$n$ (Sample Size Per Group)</td>
<td>50 to 150 by 20</td>
</tr>
<tr>
<td>Measurement Time Input Type</td>
<td>Equally Spaced Measurement Times</td>
</tr>
<tr>
<td>$M$ (Number of Measurement Times)</td>
<td>4</td>
</tr>
<tr>
<td>$\mu_i$'s Input Type</td>
<td>$\mu_1$, $\mu_2$, ..., $\mu_G$</td>
</tr>
<tr>
<td>$\mu_1$, $\mu_2$, ..., $\mu_G$</td>
<td>5 5 7 10</td>
</tr>
<tr>
<td>$\sigma$ (Standard Deviation)</td>
<td>14.3</td>
</tr>
<tr>
<td>Pattern of $\rho$'s Across Time</td>
<td>Linear Exponential Decay</td>
</tr>
<tr>
<td>$\rho$ (Base Correlation)</td>
<td>0.8</td>
</tr>
<tr>
<td>Base Time Proportion</td>
<td>0.1</td>
</tr>
<tr>
<td>Emax (Max Decay Exponent)</td>
<td>4</td>
</tr>
<tr>
<td>Missing Input Type</td>
<td>Pairwise Observed Proportions on Spreadsheet</td>
</tr>
<tr>
<td>Columns of Pairwise Observed</td>
<td>C1-C4</td>
</tr>
</tbody>
</table>

You must enter the pairwise probabilities table using the Spreadsheet icon to the right.
Output

Click the Calculate button to perform the calculations and generate the following output.

### Numeric Results

- **Measurement Times:** Equally spaced
- **Correlation:** Linear exponential decay, with $E_{max} = 4$ and $Base \ Time \ Prop = 0.1$
- **Missing Pattern:** N/A. Matrix of observant probabilities entered in columns C1-C4.
- **Number of Groups:** 4

<table>
<thead>
<tr>
<th>Power</th>
<th>N</th>
<th>ni Set</th>
<th>M</th>
<th>Time Set</th>
<th>Ave Resp</th>
<th>SD Grp</th>
<th>Std Dev</th>
<th>Base Corr</th>
<th>First Row Corr</th>
<th>Alpha</th>
<th>Miss</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.4901</td>
<td>200</td>
<td>ni(1)</td>
<td>4</td>
<td>T(1)</td>
<td>$\mu(1)$</td>
<td>2.05</td>
<td>14.30</td>
<td>0.8000</td>
<td>p1(1)</td>
<td>0.050</td>
<td>n/a</td>
</tr>
<tr>
<td>0.6470</td>
<td>280</td>
<td>ni(2)</td>
<td>4</td>
<td>T(1)</td>
<td>$\mu(1)$</td>
<td>2.05</td>
<td>14.30</td>
<td>0.8000</td>
<td>p1(1)</td>
<td>0.050</td>
<td>n/a</td>
</tr>
<tr>
<td>0.7673</td>
<td>360</td>
<td>ni(3)</td>
<td>4</td>
<td>T(1)</td>
<td>$\mu(1)$</td>
<td>2.05</td>
<td>14.30</td>
<td>0.8000</td>
<td>p1(1)</td>
<td>0.050</td>
<td>n/a</td>
</tr>
<tr>
<td>0.8528</td>
<td>440</td>
<td>ni(4)</td>
<td>4</td>
<td>T(1)</td>
<td>$\mu(1)$</td>
<td>2.05</td>
<td>14.30</td>
<td>0.8000</td>
<td>p1(1)</td>
<td>0.050</td>
<td>n/a</td>
</tr>
<tr>
<td>0.9100</td>
<td>520</td>
<td>ni(5)</td>
<td>4</td>
<td>T(1)</td>
<td>$\mu(1)$</td>
<td>2.05</td>
<td>14.30</td>
<td>0.8000</td>
<td>p1(1)</td>
<td>0.050</td>
<td>n/a</td>
</tr>
<tr>
<td>0.9466</td>
<td>600</td>
<td>ni(6)</td>
<td>4</td>
<td>T(1)</td>
<td>$\mu(1)$</td>
<td>2.05</td>
<td>14.30</td>
<td>0.8000</td>
<td>p1(1)</td>
<td>0.050</td>
<td>n/a</td>
</tr>
</tbody>
</table>

**Set (Set Number): Values**
- ni(1): 50, 50, 50, 50
- ni(2): 70, 70, 70, 70
- ni(3): 90, 90, 90, 90
- ni(4): 110, 110, 110, 110
- ni(5): 130, 130, 130, 130
- ni(6): 150, 150, 150, 150
- T(1): 0.00, 0.33, 0.67, 1.00
- $\mu(1)$: 5.00, 5.00, 7.00, 10.00
- p1(1): 1.0000, 0.6725, 0.5249, 0.4096

The standard reports are displayed.